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1. New Features

1.1 What's New in GMG ProfileEditor?

This chapter summarizes all major changes that have been applied to the program since the latest release.
It is recommended that experienced GMG ProfileEditor users read the information provided in this chapter
very carefully, so that they can take full advantage of all new software features. Please follow the links for
a detailed description of the new features.

New Feature Description Where to Find See Also

Compensate
color shifts
caused by
OBAs

New option Optical Brightener Compensation: Many print media come
with varying amounts of optical brightening agents (OBAs) in their coating
that may cause color shifts. If you are using media with optical brighteners,
this option will help you to produce profiles that compensate the negative
impact of OBAs while maintaining the whiteness levels und image contrast.

MX4: Common tab >
Optical Brightener
Compensation

"Optical
Brightener
Compensation
(OBC)" on
page 2

Improved
profile
quality

When generating CMYK output values, values are automatically smoothed
and outliers are removed.

Measure menu > Calculate
CMYK from Target
Values, Calculate CMYK
from Current Values,
Calculate CMYK Using
Gamut Mapping

Enhanced
options to
preserve the
ink purity

Unlike device independent profiles, device dependent profiles have the
ability to preserve pure colors. Applying improved algorithms, GMG
ProfileEditor enables the user to preserve the purity of primary (CMY) and
secondary (CM, CY, MY) colors and of color combinations with Black (CK,
MK, YK, CMK, CYK, MYK), keeping the colors free of contamination.

MX4, Conversion Profile:
Gamut/Separation >
ColorServer Mode >
Settings button> Purify
Colors tab.

"Purify
Colors" on
page 2

Major
overhaul of
the gamut
mapping
algorithm

When calculating new profiles, the mapping of colors between input and
output color space has been greatly improved.

Measure menu > Calculate
CMYK Using Gamut
Mapping

"New Gamut
Mapping" on
page 4

"Comparing
the Input and
Output Color
Spaces" on
page 5

"Calculating a
Profile with
Gamut
Mapping" on
page 8

"Rendering
Intents" on
page 8

"Advanced
Gamut
Mapping
Settings" on
page 10
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1.2 Optical Brightener Compensation (OBC)

Note Please select no filter (Filter = None) in the Measurement Settings if you want to create a profile
with OBC. Selecting a filter will gray out the Optical Brightener Compensation option so that it cannot be
accidentally used with filtered measurement data.

Many print media contain fluorescent whitening agents to enhance the whiteness effect. Such additives
absorb light in the UV range and re-emit light in the blue range. While our eyes perceive the increased
amount of reflected blue light as simply brighter or bluish-white, a spectrophotometer tells a different tale,
measuring shades of blue which do not match our visual impression. For example, a measured *b value of
-5 (which suggests a definite blue appearance) is usually perceived as a bright white. A profile based on
such measurement values usually produces prints with an overall bluish cast.

Some measuring devices feature a UV cut filter which blocks the UV amount of the light source of the
measuring device. Visually, however, profiles calculated with UV cut measurements tend to produce
prints that have a rather yellowish cast to them. The discrepancy between measured and perceived color
often leaves the user end up with prints that are either too blue or too yellow.

To strike a balance between those two effects, we have integrated an Optical Brightener Compensation
(MX4: Common tab). Selecting this option after measuring the target values makes GMG ProfileEditor
generate counter-balancing Lab Target Values. These counter-balancing values are based on averaged
values of a visually correct and media-neutral paper white tint. For control and flexibility, we added a
slider for further corrections towards Blue or Yellow. Generally, we recommend to use the default setting
with the handle of the slider set to the middle. If your paper, however, is strongly colored, for example,
your prints come out too yellow, you can compensate this by moving the slider towards More Blue.

Where can I view the changed target values?

Click on the 4d Color Space tab and activate the option Show Compensated Values (Optical Brightener
Compensation). The compensated a* and b* values are displayed in the Target Values columns. These
compensated values cannot be exported.

Tip Display the compensated values to know the actual Delta E values when iterating the profile. Not
displaying the compensated values does not mean they are not used, they are just not shown.

OBC and Gamut Mapping

The Optical Brightener Compensation should always be activated first before performing a gamut
mapping (Measure menu > Calculate with Gamut Mapping) to get accurate results.

1.3 Purify Colors

Note The Purify Colors tab in GMG ProfileEditor allows for very specific changes of the visual appearance
of colors and should thus only be used by advanced users.

The color purity can be an important issue, for example, when dealing with graphical objects with deep
saturated colors which after a conversion may print slightly different (though color accurate). In such
cases, you might need to effect a trade-off between colorimetric accuracy and color purity.

Generally, it is recommended to calculate a profile first without using the options on the Purify Colors tab.
Check the calculated profile and see to which extent primary and secondary colors are contaminated by
other colors. If the contamination is rather small, for example only reaching up to 2 or 3 %, it makes sense
to recalculate the profile preserving certain primary and/or secondary colors, to save the profile under a
different name, and then compare the two profiles.

As a rule of thumb, the smaller the contamination, the smaller will be the impact of the Purify Colors
options on Delta E.
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How to keep colors pure

Start GMG ProfileEditor.

On the File menu, click Open and select the CMYK conversion profile you want to recalculate using
Purify Colors options.

Under Gamut/Separation, click the Settings button.
A new dialog box is displayed.

Click the Purify Colors tab.

Select the desired options to keep primary and/or secondary colors pure.

Click OK to confirm your choice.

On the Measure menu, click Calculate with Target Values.
The target values will be computed with the gamut file to produce the output values of the profile.

On the Measure menu, click Estimate Current Values from CMYK to calculate the color values as
they would be printed.

On the File menu, click Save As and save the modified profile under a new name.

Under Options, click GamutViewer.
The GMG GamutViewer is displayed.

Under Reference Gamut, click the Open button and select the original profile.

Under Sample Gamut, click the Open button and select the modified profile.

Both profiles are displayed on the 3D tab. You can choose between different display modes to assess the
applied changes. If the sample gamut does not encompass the reference gamut, the respective colors
cannot be represented. Should this only pertain to minor color areas at the outer margin of the gamut, the
profile may still be acceptable. If the deviations are far out of range, you might have selected too many
Purify Colors options. In this case, deselect some options and try again until you are satisfied with the
result.

1.3.1 Purify Colors Settings

The following table shows all options to preserve the purity of CMY color values. The column Affected
Range contains operational values which indicate the impact of the option. These values can, of course,
differ (due to different profiles) and are intended to be a rough guide. The higher the number, the bigger is
the potential change on the input colors.

Option Affected Range Short Description

Keep Pure
Gradations

9 Keeps the gradations of the selected primary color(s) pure when calculating the profile.

Example: The conversion profile would normally convert an input color of C=20, M=0, Y=0 to an
output color of C=15, M=3, Y=4. If you select Cyan, the final output color may become C=15, M=0,
Y=0 (depending on the used profile). Thus the color tone compensation in the Cyan axis is applied,
but color tones other than Cyan are ignored.

Keep Pure
Secondary
Colors

81 When creating a CMYK Conversion Profile, you can also keep secondary colors pure. Reds
comprises any combination of Yellow and Magenta without Cyan, Greens any combination of
Yellow and Cyan without Magenta, and Blues any combination of Magenta and Cyan without
Yellow.

Example: When selecting Reds, the color shifts of Yellow and Magenta values are applied according
to the profile, but no Cyan is added to keep the Reds pure.

Keep Pure
Solids

1 This option forces 100 % solid colors to remain unchanged when calculating the profile. It makes
sense to select this option in accordance with what you selected under Keep Pure Gradations, as
only one fulcrum is affected.

Example: 100 % Cyan is kept at 100 % Cyan, if 100 % Cyan is selected.
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Option Affected Range Short Description

Keep Solids
With

18 Keeps all solid colors unchanged along the selected 100% lines.

Example: If you select 100% M or 100% Y, the axis from Yellow to Red and Red to Magenta is kept
at 100%.

The below settings include the Black axis, thus enabling the preservation of Black and combinations with
Black (CMYK). These options aim at separation-preserving profiles with heavy GCR settings.

Option Affected Range Short Description

Keep Pure 81 All colors made up of only C+K, M+K or Y+K remain pure, ignoring all other color tones.

Example: The conversion profile would normally convert a blue input color of C=35, M=0, Y=0,
K=75 to an output color of C=30, M=2, Y=3 and K=71. If you select C+K, the final output color
may be C=30, M=0, Y=0, K=71. Thus Cyan and Black are adjusted, and all other color tones are
ignored.

Keep Pure 729 Similar to the above option, but including a third color. All colors composed of the selected primary
inks (including Black) remain pure. This option should be used with care as many fulcrums are
affected potentially changing the visual appearance of the colors to a great extent.

Example: The conversion profile would normally convert an input color of C=5, M=30, Y=30, K=30
to an output color of C=2, M=32, Y=32 and K=34. If you select M+Y+K, the final output color may
be C=0, M=32, Y=32, K=34. Thus Magenta, Yellow and Black values are adjusted and all Cyan
values are ignored.

Keep Pure
Gradations

9 Colors which are made up of a primary color and 100% Black are converted according to the
profile, keeping Black at 100%.

Example: The conversion profile would normally convert an input color of C=80, M=0 , Y=0 ,
K=100 to an output color of C=78, M=2, Y=3 and K=80. If you select C if 100%K, the final output
color may be C=78, M=0, Y=0, K=100. Thus Cyan is adjusted according to the profile and Black
forced to 100%. Magenta and Yellow values are ignored.

Keep 100%
Black

729 This option keeps all colors unchanged which contain 100% Black and should be used with care as
many fulcrums are affected potentially changing the visual appearance of the colors to a great extent.

Example:: The conversion profile would normally convert an input color of C=0, M=0, Y=50,
K=100 to an output color of C=0, M=10, Y=40 and K=80. If you select 100% K, the final output
color may be C=0, M=10, Y=40, K=100, forcing K to 100%.

1.4 New Gamut Mapping

Apart from a detailed description of new features, the following chapters also include useful tips on how to
evaluate your target color space and how to choose the best rendering intent for your particular situation.

All advantages on a glance:

High-quality colors matching the original colors as intended by the creator of the document

Excellent and stable gray balance

Bright and colorful images with a maximum of contrast and detail

With the new adjustable Black Point Compensation feature, you will be able to use the full dynamic
range of the shadows of the target color space and to achieve a deeper black.

Use gamut mapping algorithms predefined by GMG ColorExperts or use you own custom settings.

The gamut mapping settings in GMG ProfileEditor have been simplified and streamlined while still
offering a maximum flexibility to fine-tune a profile. Only rendering intents are available that will
give highest quality results.
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RGB-to-CMYK separations (in GMG ColorServer) / PhotoProof profiles (in GMG ColorProof): The new
rendering intent Best Visual Impression – Relative Colorimetric has been optimized for RGB-to-
CMYK separations. With this new rendering intent, you can achieve the highest saturation within the
technical limitations of the target color space.

CMYK-to-CMYK profiles:

The new rendering intent Best Visual Impression – Relative Colorimetric has been optimized for
color conversions where the input color space is almost identical to the output color space.

The new rendering intent Best Visual Impression – Perceptual has been optimized for color
conversions where the input color space is considerably larger than the output color space.

See also:

l "Comparing the Input and Output Color Spaces" on page 5

l "Calculating a Profile with Gamut Mapping" on page 8

l "Rendering Intents" on page 8

l "Advanced Gamut Mapping Settings" on page 10

1.4.1 Comparing the Input and Output Color Spaces

When you create an RGB-to-CMYK separation, a CMYK-to-CMYK conversion, a digital production, or a
proof profile, comparing the input and the output color space is essential for deciding which profiling
method to use and to get a feeling for the print quality you can expect from the target printing system.

If the output color space is considerably smaller than the input color space, it will technically not be
possible to reproduce the input colors in the output color space. In other words: The target printing system
in combination with the target print medium will physically not be able to print the input colors. With a
good profile, you will be able to get the most out of the system.

In our software, the input color space is referred to as the Target Values (because they represent the target
colors you want to achieve) and the output color space is referred to as the Gamut (meaning the available
gamut of the target printing system).

You can use GMG GamutViewer to compare the input color space (Target Values of the profile) with the
output color space (Gamut of the profile). On the Tools menu, click Compare Gamut/Target Values to
show a comparison of both gamuts in 3D or 2D view. You can also use GMG GamutViewer to compare
any two color spaces.

If the output color space is much smaller than the input color space, there are basically two possibilities:
 You can either clip all colors that do not fit into the output color space (the so-called out-of-gamut colors)
or scale the input color space to fit into the smaller output color space (gamut mapping). Imagine a
sponge or any other soft material you want to fit into a smaller box: You can either squeeze the sponge or
cut off the edges until it fits. If you squeeze it, you will increase the density of the sponge. If you cut it,
you will loose material. The situation is similar for gamut mapping: If you scale the input color space, all
color values will be redistributed to achieve a similar spatial distribution as on the input color space. This
means that the absolute color values will change, which shows when you measure them with a
spectrophotometer. But if you look at the printed image, it will "look good", that is, the visual impression
of the original image will be preserved. If you clip the color space, higher saturated colors will be lost, but
the in-gamut colors will be preserved. Even though most colors will not be changed, the visual impression
of the original image might be lost. For example, a nice gradation in a bright blue sky might be converted
to a uniform single-color area.

In GMG ProfileEditor, using the clipping method or absolute colorimetric rendering intent would mean to
use the Calculate with Target Values feature (from the Measure menu). If the input and output color
spaces are very different, this is generally not recommended, as you will loose a lot of color information.
This method is best if the output color space covers the input color space or if there are only minor
differences (that are not relevant for the processed images).

GMG ProfileEditor offers high-quality gamut mapping algorithms that will achieve the best possible result
on the target printing system.
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In the following, we will discuss some typical examples of color space conversions, to help you decide
which profiling method and rendering intent might be best for your particular situation.

Input and output color spaces are similar

Fig. 1 Input "ISO Coated v2 (39L)" compared to output "PSO LWC Improved (45L)".

The red solid surface represents the smaller output color space, showing through the color grid of the input
color space.
The gamut depicted in red is quite close to the input color space. The two printing conditions sheet-fed
and web offset (on coated paper) can reproduce very similar color spaces. For a conversion profile, you
can use the rendering intent Best Color Accuracy – Relative Colorimetric. If a color-accurate reproduction
is very important and image motifs do not use a lot of highly saturated colors (on the hull of the gamut),
you could even create a profile without gamut mapping.

Similar color spaces, but different black point

Fig. 2 Input "ISO Coated v2 (39L)" compared to output "PSO Uncoated ISO12647 (47L)".

In the highlights, the two color spaces are more or less identical. As the black point on uncoated media is
lighter than on coated media, the output color space "PSO Uncoated ISO12647 (47L)" is limited in the
shadows. The shadows will lighten a lot under the target printing condition.
As the two color spaces have a similar white point, you can use the rendering intent Best Color Accuracy
– Relative Colorimetric. You can control shadow clipping and detail loss in the shadows by using the
Black Point Compensation feature.
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Output color space is much smaller than input color space

Fig. 3 Input "ISO Coated v2 (39L)" compared to output "PSO SNP Paper (42L)".

The newsprint color space is much smaller than offset coated. To match the visual impression of the
original image as best as possible, use the Best Visual Impression – Perceptual rendering intent. As at least
the shape of the color spaces are similar, it will be possible to achieve a close matching of the visual
impression after scaling the input color space to the output color space.

Separation of RGB data to CMYK

Fig. 4 Input "Adobe RGB (1998)" compared to output "ISO Coated v2 (39L)".

This comparison shows a typical problem when printing RGB images: The printing system (offset coated in
this example) can reproduce only a much smaller color space. Therefore, you will always need to use the
rendering intent Best Visual Impression – Perceptual for RGB-to-CMYK separations.
The shapes of the color spaces are also very different, especially in the green and blue areas. To match
the shape of the output color space, scaling alone will not be sufficient; it will also be required to clip out-
of-gamut areas after the scaling. You can put more emphasis on the lightness or on the saturation of out-of-
gamut colors by moving the Out-of-Gamut Colors Clipping Mode slider.
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1.4.2 Calculating a Profile with Gamut Mapping

Note When a profile is calculated with gamut mapping, fulcrums are added to the profile. This means, an
optimization of the profile by iteration (Calculate with Current and Target Values) will not be possible
anymore after gamut mapping. If you want to optimize the profile, you will need to use the method
without gamut mapping (Calculate with Target Values) to create a first version of the profile. However, if
the source and target color space are quite different, you might not be able to reach the target values
within narrow tolerances, resulting in high delta E values.

Note If you use the command Calculate with Gamut Mapping, make sure the option Use Paper Tint
Correction on the Separation page (Common tabbed page in the profile > Gamut/Separation > Settings) is
not selected. This option conflicts with the Paper Tint Compensation settings of the gamut mapping mode.

How to calculate a profile with gamut mapping

1. On the Measure menu, click Calculate with Gamut Mapping.
The Gamut Mapping dialog box will be displayed.

2. From the Mode drop-down list, select the rendering intent you want to use and adjust the parameters
if required.

3. Click the Calculate button to calculate the profile.

A new profile will be calculated based on the existing one. New target values (referring to the output
color space) will be calculated based on the Separation settings (defined on the Common tabbed page in
the profile > Gamut/Separation > Settings) and the Gamut Mapping settings.

The target values will then be automatically computed with the linked gamut file to produce the CMYK
output values of the profile, including an automated smoothing algorithm (same functionality as Calculate
with Target Values).

The profile is now ready-to-use.

See also:

l "Rendering Intents" on page 8

1.4.3 Rendering Intents

Gamut mapping is performed with specific calculation modes, also called rendering intents.

Note For RGB-to-CMYK profiles, gamut mapping is always recommended, as CMYK color spaces are
generally considerably smaller than RGB color spaces.

When do I use which rendering intent?

Choosing an ideal rendering intent depends on the differences between the input and output color space of
the profile and on the purpose for which the profile will be used.

When comparing the input and output color space, the luminance range (dynamic range) is the most
important factor. If the input and output color spaces are almost identical, input colors can be reproduced
on the target printing system. If the luminance range of the input color space is much higher than the
luminance range of the output color space, input colors must be either scaled or clipped to match the
limited luminance range.

You can use GMG GamutViewer to compare the input color space (Target Values of the profile) with the
output color space (Gamut of the profile). On the Tools menu in GMG ProfileEditor, click Compare
Gamut/Target Values to show a comparison of both gamuts in 3D or 2D view.

See also a detailed discussion of typical examples in the following chapter: "Comparing the Input and
Output Color Spaces" on page 5

In the following, we provide a few hard-and-fast rules to help you decide which rendering intent you might
need.
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Input color space = RGB? => If yes, use Best Visual Impression – Perceptual.

Input color space = CMYK

Profile will be used for proofing or validation prints? => If yes, do not use gamut mapping.
Instead, use the Calculate with Target Values feature (from the Measure menu). (Make sure the
print system you are using is able to reproduce the simulation color space. If you want to print
RGB data, you will need to normalize the data to the CMYK simulation space before applying
the proof profile.)

Output color space completely covers the input color space? => If yes, do not use gamut
mapping. Instead, use the Calculate with Target Values feature (from the Measure menu).

Output color space almost identical to input color space (comparable luminance ranges)?
(Example: using two similar print media on the same printing system) => If yes, use Best Color
Accuracy – Relative Colorimetric. In-gamut colors will not be changed by the profile. The
higher the difference between the two color spaces, the more out-of-gamut colors will be
clipped.

Output color space considerably smaller than input color space? (Example: Conversion from
offset to newsprint) => If yes, use Best Visual Impression – Perceptual. The higher the difference
between input and output color space, the higher will be the gamut compression, that is, the
higher will be the colorimetric deviation from the original colors.

The rendering intents are explained in more detail in the following table.

Available
options

Description

Best Visual
Impression –
Perceptual

This rendering intent aims at preserving the visual impression of the original image, including saturation and detail, in
the limited output color space.

The color space will be scaled to fit into the output color space, that is, all color values including in-gamut colors will
be redistributed. Central colors are remapped more precisely, that is, changed less than colors at the edges of the
gamut.

Best Color
Accuracy –
Relative
Colorimetric

(Only available for CMYK-to-CMYK profiles)

This rendering intent aims at achieving the highest color accuracy. In-gamut colors are reproduced in a color-accurate
manner in the output color space. Higher saturated (out-of-gamut) colors are clipped.

Relative colorimetric aligns the white point of the input color space to the output color space, leading to a color
compensation when printing on tinted paper. As a result, all in-gamut colors are modified with respective to the new
white point. Apart from that, changes to in-gamut colors are kept to a minimum, so that a maximum color accuracy is
achieved.

You can manually adjust the Paper Tint Compensation and thus the impact on the in-gamut colors.

Contrast and detail in saturated areas might be lost when using this rendering intent. You can manually adjust the
contrast (Contrast Adjustment).

An adjustable Black Point Compensation can be used to avoid shadow clipping.

Out-of-gamut colors are clipped. You can put more emphasis on the lightness or on the saturation of out-of-gamut
colors by moving the Out-of-Gamut Colors Clipping Mode slider.

No Gamut
Mapping
(absolute
colorimetric)

Creating a profile without gamut mapping has a similar meaning than using an absolute colorimetric rendering intent
for ICC based color management. In-gamut colors are color-accurately reproduced and out-of-gamut colors are
clipped.

Without gamut mapping, it might not be possible to reproduce the Source Color Space (Target Values) in the Output
Color Space (Gamut), depending on the technical limitations of the printer–medium combination and depending on
how different the printer gamut is from the input color space. The deviation between Current and Target values might
be quite high, resulting in high delta E values. It might not be possible to achieve much improvement even by using an
iteration cycle.

If you want to create a profile without gamut mapping in GMG ProfileEditor, use the Calculate with Target Values
feature (from the Measure menu).
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1.4.4 Advanced Gamut Mapping Settings

For most applications, you can use the default settings by selecting a rendering intent from the drop-down
list. In some cases, it might be required to manually adjust the gamut mapping settings by moving the
sliders. Optimum gamut mapping settings depend mainly on the differences between the input and output
color space and to a certain degree also on the image motifs you want to process. You might need to
empirically determine the ideal settings for your particular situation. To point you into the right direction,
the concept behind the gamut mapping settings are explained in the following. Available settings depend
on the selected rendering intent.

Paper Tint Compensation

This parameter defines how much the paper tint of the output color space or target print medium (defined
by the gamut linked within the profile) will affect the printed colors.

The Paper Tint Compensation mainly affects the gray balance and less saturated colors.

Generally recommended is a Paper Tint Compensation of 0, as this setting preserves the paper white and
the gray axis of the original image.

Fig. 5 Paper tint compensation example.

In this example, a color space is converted to a color space with a more yellowish paper tint, for example,
from "ISO Coated v2 (39L)" to "ISO Uncoated Yellowish (30L)". That means, the conversion profile shifts
the color space from Blue to Yellow.
In a color space, the gray axis connects the paper white with the black point. In the diagram, you can see
three gray axis curves, each for a different Paper Tint Compensation value (0, 5, 10).
With a Paper Tint Compensation of 10, the gray axis is perceptually mapped to the output color space,
without taking the input color space into account.
With a Paper Tint Compensation of 0, the profile preserves the original gray axis as best as possible. As
you can see, there is a sharp bend in the curve that could potentially result in visible steps in the
highlights (depending on image motifs).

Move the slider towards Source if you want to preserve the original colors, thus "ignoring" the new
paper tint. Please note that especially in the highlights, a prominent paper tint in the target color
space such as Yellowish cannot be fully compensated. For example, a pure white color will be out of
gamut.

If you move the slider towards Destination, the new paper tint will have more effect on the colors,
especially on the highlights and on the gray balance.
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Contrast Adjustment

Defines the lightness for the highlights and shadows.

If you move the slider towards Low, the highlights will be darker and the shadows will be lighter, that
is, you decrease the contrast. You will also achieve more detail in the shadows.

If you move the slider towards High, the highlights will be lighter and the shadows will be darker,
thus increasing the contrast.

Black Point Compensation (Relative Colorimetric)

If the black point in the output color space, for example, when printing on uncoated media, is lighter than
in the input color space, it will not be possible to reproduce very dark colors. When using a relative
colorimetric rendering intent, this would mean that out-of-gamut colors will be clipped, resulting in a loss
of shadow detail. Using the adjustable Black Point Compensation feature can help avoid shadow clipping.

You can increase the Black Point Compensation level by moving the slider towards Full. Black Point
Compensation preserves image detail in the shadows by minimizing clipping in the shadows. Thus,
the full dynamic range of the output color space in the shadows can be used.

If no Black Point Compensation is used by moving the slider to the left side (None), changes to in-
gamut colors in the shadows are minimized, though detail might be lost. Deactivate Black Point
Compensation if you want to avoid color shifts.

Out-of-Gamut Colors Compression Level (Perceptual)

This setting directly affects the colorfulness (chroma) of an image.

It defines the balance between scaling out-of-gamut colors to new color values and clipping of out-of-
gamut colors.

Move the slider towards None (Clipping) if you want to change in-gamut colors as little as possible.
Out-of-gamut colors are clipped. As a side effect, image detail and contrast might be lost in highly
saturated areas.

Move the slider towards Full if you want to use the full range of the output color space to represent
all input colors. Out-of-gamut colors are scaled to the target gamut, resulting in a redistribution of all
color values, including in-gamut colors. Clipping is minimized. As a side effect, undesired color
shifts might occur and image detail might be lost in less saturated areas. Image colors might appear a
bit dull, closer to gray.

Fig. 6 Clipping mode.

The black curve shows the chroma of the input color space and the red one shows the chroma of the
output color space. The diagram on the left side marks a sample of five color values in the input color
space or original image (target values) as black dots. On the right side, the five values are mapped to the
output color space. The mode None (Clipping) was used. This means that the chroma of the four color
values that are in-gamut of the output color space will not be changed. The fifth value, which is out of
gamut, is clipped. This means that the colors represented by the fourth and fifth dot will be mapped to the
same color value, that is, will print identical, resulting in color information loss.
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Fig. 7 Scaling mode.

This diagram shows the same situation as the preceding one, but with the Out-of-Gamut Colors
Compression Level set to Full. Out-of-gamut colors are not clipped, but scaled to fit into the output color
space. All five color values are reproduced and no color information is lost. All five color values are
redistributed, that means, in-gamut colors are changed as well.

Out-of-Gamut Colors Clipping Mode

In the last step of the gamut mapping process, the Out-of-Gamut Colors Clipping Mode defines to which
position on the surface of the target gamut hull all remaining out-of-gamut colors will be mapped.

Move the slider towards Preserve Saturation if you want to achieve more colorful images. This is
generally preferred if images have loud colors, for example, business chart graphics.

Move the slider towards Preserve Lightness if you want to bring out more detail, more depth, and
finer textures. This is generally preferred for photo or fine art printing.
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